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I.  
Introducing SWAMI GenoType™ 
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Imagine using a simple, web-based form where you enter your client’s blood type and secretor 
status, finger lengths and body measurements, fingerprint patterns, along with age, gender and health 
issues. 
 
Then, you hit Print Diet Report and in a matter of seconds watch a highly personalized, fifty-
page dietary program appear ready for printing. After 12,600,000 individual calculations (performed 
on 225 individual nutrient values found for each of 800 different foods, matched to the results of 
your measurements and intake facts), your client’s personalized diet is now ready! 
 
Welcome to SWAMI GenoType™ 
 
SWAMI GenoType™ is a sophisticated, second-generation collection of diet analysis and reporting 
software programs written by Dr. Peter D'Adamo, developer of The Blood Type Diet and The 
GenoType Diet Systems.  Utilizing a variety of biometric measurements, dermatoglyphic (fingerprint) 
data and serologic markers such as blood type, SWAMI GenoType™ will output a professionally 
designed diet plan suitable for everyday use.  
 
Programming SWAMI GenoType™ was a mammoth task, undertaken by Dr. Peter D'Adamo who 
had both the data and the programming skills to bring it to life.  SWAMI GenoType™ has been 
refined by over two years of constant use at The D’Adamo Clinic in Wilton, CT.  Dr. D’Adamo is a 
world-renowned expert in nutrition and genomics, and he wrote the SWAMI GenoType™ diet 
software harnessing the power, precision, and speed of computers and artificial intelligence to tailor 
unique, one-of-a kind diets for individuals. 
 
Incorporating a variety of serotyping polymorphisms, biometric measurements and dermatoglyphic 
data SWAMI GenoType™ allows you to add an astounding amount of new detail to your dietary 
recommendations and supplies you with an incredibly detailed, reader friendly and versatile report, 
along with a complete Meal Planning Module that can call upon a universe of over 900 recipes that 
are prescreened to work with your diet choices. 
 
SWAMI GenoType™ is designed to grow as your horizons expand. Planning on adding additional 
nutritional information? Do you have information on your ancestral DNA haplogroups? SNPS? New 
lab findings?   No problem! SWAMI GenoType™ can incorporate these data, and more. 
 
SWAMI GenoType™ features an attractive, well-structured user interface. Web-based, so you are 
always using the latest version of the software. Extensive help and information screens make getting 
your data into SWAMI GenoType™ a snap. And in the end, you will receive a beautiful, personalized 
diet plan. 
 
NOW it’s time for you to get started! Harness the power of a truly personalized nutrition program 
with SWAMI GenoType™! 
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Getting Started  
 
Once you have purchased your SWAMI GenoType™ license, you will receive an account number, 
user name, and password. 
 
SWAMI GenoType™ is web-based, which has the advantage of guaranteeing that you are always 
using the most recent implementation. Using SWAMI GenoType™ is as easy as doing any other 
function in your internet browser but formatting was worked out for the Mozilla “Firefox” browser. 
SWAMI GenoType™ also works well in Safari and in most versions of Internet Explorer. 
 
You can download Firefox from here: 
 
http://www.mozilla.com/en-US/firefox/ 
 
Type or copy this URL to your browser and we’ll get started. 
 
http://www.swamigenotype.com 
 
You should see the following welcome screen: 
 
 

 
 

SWAMI GenoType™ Log In Screen 
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This is the LOGIN  SCREEN, and it is typically where you will begin using SWAMI GenoType™. 
However, before we jump into the program, let’s make sure that everything is set properly on your 
computer and Internet browser.  
 
Click on the tab labeled SWAMI  SUPPORT. This link will take you to the SWAMI GenoType™ 
customer support area. 
 

 
 

SWAMI GenoType™ Status Screen 
 
This screen contains some helpful information about the state of your browser. In order for SWAMI 
GenoType™ to work correctly, you must have two critical settings on your browser properly set. 
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SWAMI Status Report 

Cookie Status 
 
SWAMI GenoType™ uses cookies to keep track of your information as you move from screen to 
screen. These will need to be enabled on your browser for SWAMI GenoType™ to work properly.  
A cookie is a small bit of data that keeps track of your purchases as you move from page to page. If 
cookies are not enabled on your browser, the program has no way of remembering who you are 
and what data you’ve entered. 
 

Solution: 
 
The Help portion of the toolbar on most browsers will tell you how to set your browser to accept 
new cookies, how to have the browser notify you when you receive a new cookie, or how to disable 
cookies altogether. Additionally, you can modify the settings for similar data used by browser add-
ons, such as Flash cookies, by changing the add-on's settings or visiting the website of its 
manufacturer. 

JavaScript Status 
 
JavaScript is a web programming language that enhances the function of the browser. SWAMI 
GenoType™ uses JavaScript extensively for most of its intake forms and HELP screen pop-up 
windows.  
 
Cause: 
 
You may have JavaScript disabled on your browser. This website uses JavaScript (a computer 
language) to communicate with your browser. 
 
Solution: 
 
Below are instructions for enabling JavaScript for browsers we support. 
 
Macintosh Mozilla browser 
 

• From the browser, select the Mozilla menu and select Preferences 
• Click the arrow next to Advanced 
• Click Scripts & Plug-ins 
• Click to check Navigator, beneath Enable JavaScript for 
• Click OK 
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Macintosh Firefox browser 
 

• From the browser, select the Firefox menu and select Preferences 
• Depending on your browser version, select the Web Features icon in the left column or 

select the Content icon in the top row 
• Click to check Enable JavaScript 
• Click OK 

 
Windows or Linux Mozilla browser 
 

• From the browser, select the Edit menu and select Preferences 
• Click the arrow next to Advanced 
• Click Scripts & Plug-ins 
• Click to check Navigator, beneath Enable JavaScript for 
• Click OK 

 
Windows or Linux Firefox browser 
 

• From the browser, select the Tools menu and select Options 
• Depending on your browser version, select the Web Features icon in the left column or 

select the Content icon in the top row 
• Click to check Enable JavaScript 
• Click OK 

 
Windows Internet Explorer 5.x  6.x 7.x browser 
 

• From the browser, select the Tools menu and select Internet Options 
• Select the Security tab 
• Click the Custom Level button at the bottom. The Security Settings dialog box will pop up 
• Scroll down to the Scripting category and enable Active Scripting. Allow paste operations via 

script and Scripting of Java applets 
• Click OK on the Security Settings dialog box, then on the Internet Options dialog box 
• Click YES in response to any confirmation question 
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Browser Status 
 
The SYSTEM STATUS screen also provides some interesting information on what browser you are 
using, which operating system your computer is running, etc. This information can be helpful if you 
are working out a problem with Technical Support and they need to know the environment that 
SWAMI is running on locally on your machine. 
 
The other lower tabs will lead you to other areas of the SWAMI GenoType™ Support System. They 
are discussed in Chapter VIII. 

Pop Ups 
 
Some people prefer to disable pop-up screens when browsing the Internet.  Most SWAMI 
GenoType™ on line help screens use pop-ups to offer advice. These pop-up screens are typically 
able to run on most browsers, even when pop-up windows are set up to be disabled. However if 
you notice that clicking on a HELP tab does not activate a help screen pop-up, check your browser 
settings to see if enabling pop-ups corrects the problem. 
 
 
 
OK, we’ve insured that your computer meets the basic requirements for running SWAMI 
GenoType™. Let’s move onto the LOGIN SCREEN and get going. 
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II.  
The SWAMI GenoType™ Interface 
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SWAMI GenoType™ employs a tabbed navigation system. As you move through the program the 
options presented in these tabs will change.  If you look at the top of the screen you will see two of 
these folder tabs. The active tab is always at the front and tabs that lead to other areas of the 
program recede a bit towards the back. 
 
 

 
 

Tabbed Navigation 
 

 
 
Since we’ve discovered that everything is working fine on your computer, click on the LOG IN/ OUT 
tab to get to the log-in screen.  
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Log In/ Out 
 
 
You will then be prompted to enter your SWAMI GenoType™ username, password and account 
information. This information was provided to you via a confirmation email you received when you 
purchased your SWAMI GenoType™ license. Go ahead and add this information (remember names 
are case sensitive) and click the LOG IN button. 
 
 

 
 
You use the LOG IN/OUT button to exit SWAMI GenoType™. This removes any cookies from the 
machine. Cookies will also be erased after 24 hours of inactivity. It is a good idea to always LOG OUT 
of SWAMI GenoType™ when you’ve completed you session. 

 

Help Tabs 
 
Most screens in SWAMI GenoType™ feature HELP tabs. These offer quick and simple assistance to 
help you get around the program. These usually open up in a small window on top of your current 
screen. 
 



SWAMI GenoType™ User Guide, Page 12 of 12 
 
 
 
 

 

 

 
 
 

III.  
Managing Your SWAMI GenoType™ Account 
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If LOG‐IN was successful, you will be taken to the first basic screen of SWAMI GenoType™, the ADD 
NEW CLIENT SCREEN. Normally this is where you want to begin your SWAMI GenoType™ session, 
since running SWAMI GenoType™ on you clients is your prime reason for using the software! 
 
However, since this is your first SWAMI GenoType session, we are going to investigate another 
screen first. Click on the MANAGE YOUR ACCOUNT tab to access your account information. 
 
This screen contains your personal information and its tabbed link is available from almost any 
screen. The information contained here was entered into your account when your SWAMI 
GenoType™ account was first created. Since this is your first visit, you’ll want to personalize this 
information a bit. Fields in red are required. If you miss a field, SWAMI GenoType™ will alert you to 
the missing data.   
 

 

 
 

Manage Account Screen 
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How SWAMI GenoType™ Accounts Work 

 
Your SWAMI GenoType™ account has two key parts:  ACCOUNT NUMBERS and your LICENSE 
NUMBERS. Your account number tracks ‘who’ you are, whereas license numbers track individual 
SWAMI GenoType™ intake client data records which are used to generate diets and menu plans.   
 
There are three basic types of SWAMI GenoType™ accounts: 
 

• Ten Use License: You purchase a license for 10 client intakes.  License is for an indefinite 
length of time. 

• Thirty-Use License: You purchase a license for 30 client intakes.  License is for an 
indefinite length of time. 

• Unlimited Monthly License: You purchase a license for 30 days, in which you can run 
an unlimited number of client intakes. 

 
Feel free to contact Technical Support at 877-226-8973 to discuss pricing and other options. 
 
Under ACCOUNT ACTIVITY you will see information about your license and account numbers. 
 
Each SWAMI GenoType™ license is for a one-time, single-use of the program on one individual.  
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Missing Fields 
 
If you miss an important field, SWAMI GenoType™ will alert you and identify the field that is missing 

End User License Agreement 
 
Read and understand the terms of the SWAMI GenoType™ End User License Agreement (EULA). A 
copy is printed online in the SWAMI Support area and Chapter X (Appendices) of this User Manual. 
 
You must agree to the terms of the EULA, and keep the EULA  AGREEMENT  BOX ticked at the 
bottom of the MANAGE YOUR ACCOUNT Screen.  
 
 
 

 

 
 

Position of the EULA check box. 
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On To The SWAMI Profile Screen 
 
Once you’ve entered your account details, press the SAVE YOUR ACCOUNT INFORMATION 
button to save your account. You will then return to this screen with your new account data added 
to the form.  
 

 
 

 
Typical SWAMI GenoType™ Message Screen 

 
 
You can return to the MANAGE YOUR ACCOUNT screen any time to update your email address, etc. 
 
Now to click on the ADD NEW CLIENT tab and begin to build your client’s SWAMI GenoType™ 
profile.
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IV.  
The SWAMI GenoType™ Client Profile 
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The CLIENT  INTAKE  SCREEN is the heart of SWAMI GenoType™. It is the ‘control tower’ that 
allows you to set the parameters which will eventually go on to become the client’s diet protocol. It 
is also the most complex part of the program. Take your time and work through this section slowly 
and carefully. You will then be rewarded with the ability to use SWAMI GenoType™ to its full 
capacity. 
 

 
 

The Client Intake Screen
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Getting Around 
 
Although it might seem a bit daunting at first, the SWAMI GenoType™ CLIENT INTAKE DATA Screen 
is very straightforward and elegant in its design. You typically move through the form from the top 
down to the bottom. At the bottom is the SAVE  SWAMI  GENOTYPE™  PROFILE  AND  CONTINUE 
button which converts your intake data into a Diet Report.  
 
Since we will be adding client intake data for the first time, click the tab advising you to ADD NEW 
CLIENT.   

Welcome 
 
SWAMI GenoType™ will usually welcome you to the program by name. Its salutation (“Good 
Morning’, “Good Evening”) is relative to Eastern Standard Time. The green ‘power button’ tells you 
that everything is in order and SWAMI GenoType™ is ready for your input.  If a problem arises this 
button will change to amber to alert you of the problem and how to correct it. 

Jump Table 
 
SWAMI GenoType™ is organized into sections labeled 1-C.  You can use the JUMP TABLE at the 
top of the screen to move around quickly without having to scroll down.   
  

Sections 
 
Each section of the SWAMI GenoType™ Intake Data Screen collects specific types of information 
about you. These are organized into the following groupings 
 

• 'Client Demographics' 
• 'Classic Genetics' 
• 'Ancestral DNA Haplogroups' 
• 'Single Nucleotide Polymorphisms' 
• 'Client Health History' 
• 'Gender Specifics' 
• 'Family History' 
• 'Laboratory Data' 
• 'Anthropometry' 
• 'Left Dermatoglyphics' 
• 'Right Dermatoglyphics' 
• 'System Drivers' 
• 'Practitioner Notes' 
• 'Food/Nutrient Matrix' 
• ‘Line Item Editor’   
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Required fields are in a red colored font 
 
 

Required Fields 
 
SWAMI GenoType™ will only run correctly if certain key information is provided. You can always 
tell if key information is required by the fact that the font of the question being asked is always red if 
the question is required and black if the question is optional. Don’t fret if you forget to answer a 
required question; SWAMI GenoType™ will alert you to the problem and tell you exactly which 
question needs to be answered. 
 
Some entry fields require numeric (number) data. If by mistake you entry text data, SWAMI 
GenoType™ will alert you to the problem and tell you exactly which question needs to be given a 
number value. 
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Timed Fields 
 
SWAMI GenoType™ users will be able to refine their client’s intake data on an ongoing basis, adding 
data as it happens or they develop it. 
 
When you first begin to add a client’s intake data information to the SWAMI GenoType™, all data 
entry fields are ‘unlocked’ and available for your input. Some 'unchangeable' fields, (such as your 
blood type, year of birth and gender) will 'lock' a few hours after the initial form is completed. This is 
to prevent someone from using one license to run diets on all their friends and family members. 
 
The locked field option will not start until you have supplied all the required information and tell 
SWAMI GenoType™ to generate a Diet Report. Rest assured, you can take your time getting your 
information together over several days and multiple sessions if needed. 
 
Having had to do that, we feel that everyone else should have the ability to further develop their 
client’s SWAMI GenoType™ intake data as their clinical course evolves. So we left a lot of the intake 
form unlocked. These unlocked parts let you continue to add additional or new data, then print out 
a fresh diet appropriate for those new circumstances. 
 
Most locked fields contain data which would be difficult to ‘get wrong’ such as the year of your birth. 
If on the slim chance that you’ve entered the wrong data in a field that has been time-locked, just 
contact Technical Support and we’ll change the field for you. 
 
If somewhere in the future we continue to develop the software to the point of another 'major 
release', we might request that folks buy a new license, but that would be optional. 
 
Let’s take a look at each individual section of the CLIENT INTAKE DATA form and introduce you to 
the logic behind why we’ve included it. 
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Section 1: Client demographics 
 
This section of the SWAMI GenoType™ profile form deals with a variety of general information 
about your client. 

First and Last Name (Required) 
You should supply the first and last names (Client First Name, Client Last Name). 

Height and Weight (Required) 
Enter your client’s height in inches and weight in pounds or use height in meters and weight in kilos. 
Whichever one you choose to use, just leave the other empty. 

Ethnicity (Required) 
Select from the pull-down menu the possible geographic and ethnic criteria (ethnicity) that is closest 
to your client. 

Year of Birth (Required, Timed)  
Select client year of birth from the pull-down menu. This field is time locked since we assume most 
people will enter the year of their client’s birth correctly within the first three hours of using the 
program! 
 

Gender (Required, Timed) 
Select client gender (male, female) from the pull-down menu. 
 

Activity Multiplier (Required) 
Activity Multiplier is a pull-down that tells SWAMI GenoType™ how active your client is. With BMI 
(‘Body Mass Index’) and BMR (‘Basal Metabolic Rate’) it is used to calculate the client’s ‘Total Daily 
Energy Expenditure’ (TDEE). The TDEE is used to set portion sizes and frequencies and help 
determine caloric requirements. 
 

Myers-Briggs Typology (Optional) 
The Myers-Briggs Indicator allows you to include the Basic Myers-Briggs personality inventories in 
your clients GenoType calculations. An abbreviated 'quick and dirty' Myers-Briggs typology test is 
available online; the link can be accessed via the pop up Help screen for this section.   
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Section 2:  Blood Groups and Related Choices  
 
This section of the SWAMI GenoType™ intake form deals with a variety of classic genetic markers. 
Fields marked in red font color are required.  North American Pharmacal (1-203-a761-0042 and 
www.4yourtype.com) has ABO, Rh, PROP and Secretor testing kits available for purchase at 
reasonable prices. The online HELP pop-up windows feature instructional videos on doing home 
blood type testing. 

ABO Blood Group (Required, Timed) 
ABO blood group is a key marker of biochemical individuality and influences every facet of 
physiology on a cellular level. It is an important influence on many digestive parameters, the chemical 
response to stress, the efficiency of the immune response. ABO blood group plays a critical role in 
embryonic development and thus is a major epigenetic and prenatal influence. Select your client’s 
ABO blood group (A, B, AB, O) from the pull-down menu. 

Your A1/ A2 Sub Type (Optional)  
A1/A2 subtype information can be added to SWAMI GenoType™ This refinement applies only to 
individuals who are blood types AB or A. This distinction exerts a mild influence on aspects of 
protein selection. 

Rh Blood Group (Required, Timed)  
Many testing cards and the blood banks also test for the Rhesus or Rh blood type, which is common 
factor in certain types of problems between a mother and her fetus. Rh haplotypes of the CDE 
system are also accepted by SWAMI GenoType™ Since the CDE haplotypes have great 
anthropological significance, their inclusion is encouraged to allow for maximum accuracy of the 
GenoType determinations.  

Secretor Status (Required)  
Think of secretor status as a volume control on your ABO blood type; secretors have their blood 
type all over the place, non-secretors don’t. For example, a blood group A ‘secretor’ has their blood 
type A marker in their saliva, sweat, semen, etc. About fifteen percent of the population are ‘non-
secretors’ and do not carry the gene to allow for this; their blood type is found only in some cells of 
the digestive tract and in their blood. The non-secretor state is significantly associated with celiac 
disease, metabolic conditions, including obesity, heart disease and insulin resistance and ulcers. 
 
How to test for ABH Secretor Status:  
Testing involves checking saliva for the presence or absence of blood type antigens. You can 
purchase a commercially available test, but unlike the at-home ABO test, it requires sending a saliva 
swab to a laboratory to be read. Epigenic Research can supply you with secretor kits that test for 
secretor status from saliva. 



SWAMI GenoType™ User Guide, Page 24 of 24 
 
 
 
 
PROP Taster Status (Required) 
This is a very useful and inexpensive test that checks to see if you have the gene to taste either 
phenylthiocarbamide (PTC) or a related substance called propylthiouracil (PROP). PROP outcome is 
critical to GenoType determination. It is highly recommended that you include this data. There are 
three possible results: 
 
• ‘Non-tasters’ taste nothing from the strip 
• ‘Tasters’ can taste the bitter substance 
• ‘Super-tasters’ have an extremely strong reaction to the bitter substance 

 
How to test for PROP Taster status: 
You'll need to purchase two types of testing strips: a PROP-containing strip and an untreated strip, 
called a control. Use PROP testing strips rather than PTC strips. PROP strips yield the same results 
and are less toxic. A control strip is important, since people can easily imagine a taste, even if it is 
not there. PROP testing is explained in The GenoType Diet. 
 
The GenoTyping Kit (TE011) from North American Pharmacal contains PROP taster strips and 
controls.   
 

Minor Blood Groups 
SWAMI GenoType will accept Lewis, MN, and Duffy. For more information on securing this 
information for your patients consult the appropriate entries in the Individualist Wikipedia 
(http://www.dadamo.com/wiki/wiki.pl/Welcome) 

 

Caffeine Sensitivity and Lactose Intolerance (Required, Timed) 
Responses to these questions are used to help determine your client’s GenoType. Select from the 
options in the corresponding pull-down menus. 
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“Presto, Chango”: Collapsible folders 
 
The next section is the first to feature collapsible folders.  SWAMI GenoType™ conserves desktop 
space by collapsing certain sections. 
 
Intake sections that contain only 'optional' data fields feature the 'down arrow' icon: 
 

 
 
It allows you to expand (show) or collapse (hide) the subsection. This is a handy way of helping to 
control the size of the intake form. When you save the form, SWAMI GenoType™ will also save 
whether the section is expanded or collapsed and when you reload the file the intake form will be 
just as you left it. To expand the submenu, tick the check box to the right of the arrow icon. To 
collapse the submenu, un-tick it.   
 
 
 
 
 
 
 

 
 

Sections with menus collapsed 
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Sections with menus expanded 
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Section 3: Ancestral DNA Genetics (Optional) 
 

 Expand this section if you plan to include this information. 
 
SWAMI GenoType™ will accept information that you may have discovered about your ‘Ancestral 
DNA’, commonly offered by such services are National Geographic’s ‘Genographic Project’: 
 
https://genographic.nationalgeographic.com/ 
 
This data is in the form of particular DNA ‘haplogroups’ traceable to your client’s ancestors.  In 
human genetics, the haplogroups most commonly studied are Y-chromosome (Y-DNA) haplogroups 
and mitochondrial DNA (mtDNA) haplogroups, both of which can be used to define genetic 
populations.   Ancestral DNA haplogroups are used (when available) for GenoType determination 
and, to a limited degree, certain food selections. 

Y Chromosome DNA Haplogroups (Optional) 
Select your client’s Y chromosome haplogroups (men only) from the pull-down menu. 
 

Mitochondrial DNA Haplogroups (Optional) 
Select your client’s Mitochondrial DNA haplogroups (men and women) from the pull-down menu. 
 
 
For more information, Wikipedia has extensive entries on Ancestral DNA. 
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Section 4: Single Nucleotide Polymorphisms (Optional) 
 

 Expand this section if you plan to include this information. 
 
 
 
The Single Nucleotide Polymorphisms subsection allows you to add SNP data on your client. 
 
Single nucleotide polymorphisms or SNPs (pronounced "snips") are DNA sequence variations that 
occur when a single nucleotide (A,T,C,or G) in the genome sequence is altered. For example a SNP 
might change the DNA sequence AAGGCTAA to ATGGCTAA. For a variation to be considered a 
SNP, it must occur in at least 1% of the population. SNPs, which make up about 90% of all human 
genetic variation, occurs every 100 to 300 bases along the 3-billion-base human genome.  
 
Two out of every three SNPs involve the replacement of cytosine (C) with thymine (T). SNPs can 
occur in both coding (gene) and noncoding regions of the genome. Many SNPs have no effect on cell 
function, but scientists believe others could predispose people to disease or influence their response 
to a drug. Although more than 99% of human DNA sequences are the same across the population, 
variations in DNA sequence can have a major impact on how humans respond to disease; 
environmental insults such as bacteria, viruses, toxins, and chemicals; and drugs and other therapies. 
This makes SNPs of great value for biomedical research and for developing pharmaceutical products 
or medical diagnostics. SNPs are also evolutionarily stable --not changing much from generation to 
generation --making them easier to follow in population studies. 
 
 
 
For more information, Wikipedia has extensive entries on Single Nucleotide Polymorphisms. 
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Common Single Nucleotide Gene Polymorphisms of Nutritional Significance: 
 

• Apolipoprotein C-III (APOC3): Inhibits lipoprotein lipase and hepatic lipase and decreases the uptake of lymph 
chylomicrons by hepatic cells. 

• Endothelial Nitric Oxide Synthase (eNOS):Produces nitric oxide which is implicated in vascular smooth muscle 
relaxation. 

• Cholesteryl Ester Transfer Protein (CETP): Hydrophobic protein involved in the transfer of insoluble cholesteryl 
esters in the reverse transport of cholesterol. 

• Lipoprotein Lipase (LPL): Plays a critical role in transporting fats and breaking down fat carrying molecules 
(lipoproteins). 

• Interleukin 6 (IL-6): Cells such as macrophages, T cells, fibroblasts, and endothelial cells produce IL-6 in defensive 
response to bacteria, viruses, and other cytokines. Regarded as a potential osteoporotic factor; may play role in 
the pathogenesis of bone loss associated with estrogen deficiency. Pro-inflammatory cytokine. 

• Methylenetetrahydrofolate reductase (MTHFR): Metabolism of folic acid and folate from the diet, required for 
homocysteine remethylation, keeping levels low 

• Methionine synthase reductase (MTRR): Involved in the reductive regeneration of methylcobalamin (a derivative 
of vit B12) which keeps homocysteine at nontoxic levels. 

• Methionine synthase (MTR): Essential for protein synthesis. Regulates homocysteine levels. 
• Cystathione beta synthase (CBS): Regulates homocysteine levels. 
• SOD2 Manganese Superoxide Dismutase (MsSOD):Free radical scavenger and has vital anti-oxidant activity within 

the cell. 
• Copper, Zinc Superoxide Dismutase (SOD3): Destroys radicals that are normally produced within the cells and 

are toxic to biological systems. 
• Glutathione S-Transferase M1, mu (GSTM1):Part of the mu class of enzymes. Functions in the detoxification of 

electrophillic compounds, including carcinogens, therapeutic drugs, environmental toxins and products of 
oxidative stress, by conjugation with glutathione. 

• Glutathione S-Transferase T1, theta (GSTT1):Part of the theta 1 class, is a member of a super family of proteins 
that catalyze the conjugation of reduced glutathione to a variety of electrophillic and hydrophobic compounds. 

• Glutathione S-Transferase P1, pi (GSTP1): A polymorphic gene encoding active, functionally different GSTP1 
variant proteins that are thought to function in xenobiotic metabolism and play a role in susceptibility to cancer 
and other diseases. 

• Vitamin D receptor (VDR): Thought to influence calcium absorption, which is mediated by vitamin D. 
• Collagen type 1 (COL1A1): Major protein of bone. 
• Tumor necrosis factor alpha (TNF a): Has been implicated in the pathogenesis of bone loss associated with 

estrogen deficiency. TNF is also a pro-inflammatory cytokine. Tumor necrosis factor is a multifunctional 
proinflammatory cytokine, with effects on lipid metabolism, coagulation, insulin resistance, and endothelial 
function. There is evidence that MUC allele distribution is different in different populations. Mucins show change 
in expression in inflammatory disease and cancer (Lesuffleur et al., 1994) and short MUC1 alleles appear to be 
associated with gastric cancer (Carvalho et al., 1997). These data provide evidence that TNF-alpha can raise the 
expression of important mucin peptide as well as mucin-associated carbohydrate antigens. 

• Angiotensin Converting Enzyme (ACE):Key enzyme in blood pressure regulation. Increases blood pressure by 
narrowing arteries, and indirectly raises blood pressure and blood volume by stimulating thirst centers in the 
brain and directing the kidneys to conserve more minerals and water. 

• Peroxisome proliferators activated receptor gamma 2 (PPARg2): Activation of the PPAR gamma 2 gene improves 
the action of insulin and its lipid metabolism. 
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Section 5: Health History (Optional) 
 

 Expand this section if you plan to include this information. 
 
 
The Client Health History subsection allows you to add data about your client's past (or present) 
health problems. 
 
This subsection is straight-forward enough. Tick the checkbox for any of the health problems the 
client has or has had. These switches drive aspects of the GenoType determination and activate a 
secondary-level food evaluation algorithm based upon known nutrient-pathology relationships. Client 
history also has an effect on determining susceptibility strengths conveyed by other genes and/or 
measurements.  
 
These switches drive the therapeutic focus of the program, a series of decisions made about specific 
foods after the effects of GenoType and blood group have been calculated.  
 
These switches also drive aspects of the GenoType determination and activate a secondary-level 
food evaluation algorithm determining susceptibility strengths conveyed by other genes and/or 
measurements. 
 

Section 6: Gender Specifics (Optional) 
 

 Expand this section if you plan to include this information. 
 
 
Again, tick the ‘Yes’ bullet for any of the gender specific health problems that the client has or has 
had. None of these results are critical, but they help shape some of the SWAMI GenoType™ food 
choices. These switches help drive the therapeutic focus of the program and help shape the 
'symmetry to gender' decisions within the program. 
 
 



SWAMI GenoType™ User Guide, Page 31 of 31 
 
 
 
 

Section 7: Family History (Optional) 
 

 Expand this section if you plan to include this information. 
 
 
None of these results are critical, but they help shape some of the SWAMI GenoType™ choices. 
Tick the ‘Yes’ bullet for any of the health problems family members may have or have had. These 
switches drive secondary aspects of the GenoType determination.  Family history also has an effect 
on determining and amplifying susceptibility strengths conveyed by other genes and/or 
measurements. 
 
 
 

Section 8: Laboratory Data (Optional) 
 

 Expand this section if you plan to include this information. 
 
 
The Laboratory Data subsection records any relevant lab data that you may have on your client. 
None of these results are critical, but they help shape some of the GenoType choices and are useful 
for 'strength-testing" the GenoType characterizations. These switches drive the therapeutic focus of 
the program, a series of decisions made about specific foods after the effects of GenoType and blood 
group have been calculated.  
 

Water Distribution 
This is the amount of intracellular water and extracellular water in the client’s body, as determined 
by bioimpedance analysis. 
 

Percent Body Fat 
This figure can be determined from classical methods or by bioimpedance analysis. 
 

Percent Lean Muscle Mass 
This figure can be determined from classical methods or by bioimpedance analysis. 
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Hydrogen Breath Test 
Used to determine if an intestinal bacterial overgrowth exists. This overgrowth can cause dyspepsia - 
ulcers (often due to H. pylori overgrowth), flatulence (gas), bloating, and many other digestive 
complaints. This testing procedure is usually performed on a fasting subject. Breath hydrogen 
readings are sequential (every twenty minutes) after a test meal. You can enter in a single value into 
the 'First Blow' field as well. 
 

Oxistress 
An Epigenic Research test that checks levels of free radicals in the urine.  This test is available from 
Epigenic Research. 
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Section 9: Anthropometry (Body Measurements)  
 
 
This is an important set of inputs, and if values can be supplied here, they can exert major effects on 
SWAMI GenoType™ food choices and GenoType determination. The online HELP pop-up windows 
feature extensive information and instructional videos on doing the basic measurements. Dr. 
D’Adamo’s book, The GenoType Diet, also features extensive descriptions of the procedures and 
measurements needed.   
 
The Home GenoTyping Kit (TE011) from Epigenic Research provides the tools you'll need to 
determine your perform many of these measurements. 
 

Handedness (Required) 
Like dermatoglyphic (fingerprint) patterns, handedness is more likely a reflection of outside 
disturbance during the prenatal period. 

Waist and Hip Measurements (Required) 
These measurements determine Waist to Hip Ratio, a general reflection of overall health. Numbers 
can be entered in either inches or centimeters. 

Cranial Measurements (Required) 
The Cephalic Index is the ratio of the width of the head to its length. Expressed as a percent 
number, it provides the simplest description of the geometric relation of two dimensions. The pop-
up inline help has an extensive section on cranial measurements. 

Carabelli Cusp or Incisor Shoveling (Required) 
Like head shape, these dental landmarks help determine long lasting effects of diet on your family’s 
epigenome (the record of epigenetic changes passed down through your family). The pop-up online 
help has an extensive section on dental landmarks and they are also discussed in Dr. Peter 
D’Adamo’s book, The GenoType Diet. 

Gonial Angle (Required) 
Jaw angle appear to also have some relevance to the record of epigenetic changes passed down 
through your family. The options are:  
 

• Wide (oval jaw shape) 
• Narrow (square jaw shape) 
• Neutral (a blend of both) 

 
The significance of jaw shape is also discussed in Dr. D’Adamo’s book, The GenoType Diet. 
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Upper Leg Space (Required) 
Without pants or other confining clothing, look at the space that is created between the thighs when 
your feet are placed together and gently touching at the ankles. The options are: 
 

• Gynic (closed silhouette) 
• Andric (open silhouette) 
• Neutral (a blend of both) 

 

Somatotype (Required)   

Wrist Encirclement (Required) 

Wrist Tendon Visibility (Optional) 
 
These body shape measurements reflect relative amounts of embryonic germ layer tissue, which is 
an important epigenetic determinant. The pop-up inline help has an extensive section on body shape 
(with instructional videos) and they are also discussed in Dr. D’Adamo’s book, The GenoType Diet. 
 

Trunk to Leg Ratio (Required)  

Upper to Lower Leg Ratio (Required) 
 
Leg and torso ratios reflect the levels of the growth factor hormones (in particular Insulin-Like 
Growth Factors 1 and 2) that were encountered in the womb and early childhood. Insulin-like 
Growth Factors are especially significant because it’s strongly associated with growth and height. 
These are critical to GenoType determination. The pop-up inline help has an extensive section on 
leg-torso measurements (with instructional videos) and they are also discussed in Dr. Peter  
D’Adamo’s book, The GenoType Diet. 
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Sections A and B: Left and Right Dermatoglyphics 

 
This is an important set of inputs, and if values can be supplied here, they can exert major effects on 
SWAMI GenoType™ calculations.  The Home GenoTyping Kit (TE011) from Epigenetic Research 
provides the tools you'll need to determine basic dermatoglyphic patterns.   

White Lines, both hands (Required) 
 
White lines are disturbances in the appearance of the fingerprint ridges such as to produce what 
appears to be white line through the fingerprint pattern. The pop-up online help has an extensive 
section on fingerprint measures (with instructional videos) and they are also discussed in Dr. 
D’Adamo’s book, The GenoType Diet. 

D2/ D4 Ratio: D2/ Index, both hands (Required) 

D2/ D4 Ratio: D4/ Ring, both hands (Required) 
 
The length ratio between the Index Finger (D2) and the ring finger (D4) can supply important 
information about the hormone balance experienced in early life.  D2/D4 ratios are critical to 
GenoType and symmetry determination. The pop-up online help has an extensive section on D2/D4 
measures (with instructional videos) and they are also discussed in Dr. D’Adamo’s book, The 
GenoType Diet. 
 
You must supply pattern data for each finger of both hands 
 

• Thumb/ D1 Ridge Pattern, both hands (Required, Timed) 
• Index/ D2 Ridge Pattern, both hands (Required, Timed)  
• Middle/ D3 Ridge Pattern, both hands (Required, Timed)  
• Ring/ D4 Ridge Pattern, both hands (Required, Timed) 
• Pinkie/ D5 Ridge Pattern, both hands (Required, Timed) 

 
The basic fingerprint pattern options that SWAMI GenoType™ accepts are 
 

• Arch 
• Composite 
• Radial Loop  
• Tented Arch 
• Ulnar Loop 
• Whorl 

 
The pop-up online help has an extensive section on fingerprint analysis (with instructional videos) 
and they are also discussed in Dr. D’Adamo’s book, The GenoType Diet. 
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SWAMI GenoType™ Client Intake Data Screen with a help pop-up window 
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Sections C: System Drivers 
 
 
This section of the SWAMI GenoType™  intake form deals with GenoType determination and a 
variety of ways that you can prioritize and filter data based on a variety of epigenetic constraints. 
Fields that are in brown type are required.  
 
This section also contains a variety of system settings that allow you to further personalize your 
client's Diet Report Printout.  
 
GenoType  
 
In this entry field you can supply the chosen GenoType for your client, or allow SWAMI 
GenoType™  to calculate it for you. If you chose to let SWAMI GenoType™  compute GenoType 
and want to examine the computations, you must save the client file, then re-open the client's file in 
re-edit mode. This field will not contain the client's computed GenoType. Additional information can 
also be found by clicking the 'GenoTyping Details' tab on the Epigenetic Engine sub menu. This 
information is also viewable by printing the Chart Report for the client.  
 
GenoHarmonic Food Clusters  
 
Allows you to set a preference for the generation of the GenoHarmonic food clustering. Consult the 
SWAMI GenoType™  manual for more information on the significance of these choices. 
 Broad Genotrophic: This setting does a low level blend of all the following parameters. 
 Enhance Global Methylation: This setting will emphasize food combinations that enhance 

methylation reactions, typically via DNA methyltransferase or by serving as a source of 
methyl donors. Good for inflammatory conditions and anti-aging strategies 

 Enhance Histone Function: This setting will emphasize food combinations that enhance 
histone deacetylase. Good for oncology management. 

 Enhance AGE Removal: This setting will emphasize food combinations that enhance glycation 
end product removal. Useful for metabolic syndrome, anti-aging and diabetic management. 

 Ubiquitinylation: This setting will emphasize food combinations that enhance removal of 
cellular debris ubiquinine pathway and the Golgi apparatus. This enhances many cellular 
functions (membrane trafficking, cell signaling, cell cycle control, X chromosome inactivation 
and the maintenance of chromosome structure) 

 
 
GenoHarmonic Threshold  
 
This sets a specific threshold for GenoHarmonic food results. Useful if your GenoHarmonic results 
are not very numerous, or too numerous.  
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DEEP BLUE Artificial Intelligence  
 
This tool allows you to use Artificial Intelligence subroutines which are not in themselves completely 
subject to the Blood Type or Genotype Diet values. 
• Fail Safe Values: This allows SWAMI Genotype to compute Failsafe values. FAILSAFE stands 

for Free of Additives, Low in Salicylates, Amines and Flavour Enhancers and is Sue Dengate's 
term for the comprehensive low-chemical, low-reactive exclusion diet formulated by 
allergists at the Royal Prince Alfred Hospital in Australia. You can expect the printout to be 
significantly restricted, so be careful using this with low compliance clients. 

• Oncology Management: This setting is a 'doomsday' feature. It reverses all the lectin 
relationships and institutes other features which use foods to disable cancer cells by virtue of 
their altered glycosylation features. 

• Endothelial Dysfunction (not yet implemented): This feature enhances endothelial healing by 
activating foods which help block soluble adhesion factors, leukocyte rolling and blood 
viscosity. 

• Inflammation: This feature activates foods containing lectins with known anti-inflammatory 
activity, foods which block complement fixation and foods which inhibit endotoxin release. 

• Metabolic Syndrome (not yet implemented): This feature activates foods containing elements 
that enhance insulin sensitivity. 

• Detoxification (not yet implemented): This feature activates foods containing elements that 
enhance cellular cleansing, inhibit excess polyamine formation and enhance hepatic phase I 
and II detoxification pathways. 

• Basic AI (not yet implemented): Use this setting if you want SWAMI GenoType™  to do a 
complete re-evaluation of the client's specifics and adjust the diet for BTD and GTD 
independent factors. For example, a positive for white lines will restrict gluten regardless of 
whether these are restricted as per the client's GenoType. 

 
 
Epigenetic Worldview  
 
Allows you to set a preference for overall tone of the diet choices by virtue of epigenetic worldview 
(Reactor, Receptor, or Thrifty). This filter will rescan the nutrient database for special 'constellations' 
of nutrients, which enhance or detract from the biologic characteristics of the selected worldview. 
Not as powerful an influence as the Food Matrix, the Worldview Filter can be used as an additional 
'water color' or 'tint' to the diet selections, imparting a secondary influence to a GenoType which 
may possess partial aspects of another epigenetic bias (a Thrifty Teacher, or a Reactive Warrior, for 
example). 
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Bias Diet Determinations Towards  
 
This tool allows you to bias the diet toward GTD, BTD or a blend of GTD/BTD food value sets. 
You can also allow SWAMI GenoType™  to calculate it for you. If you chose to let SWAMI 
GenoType™  compute the best diet value set and want to examine the computations, you must save 
the client file, then re-open the client's file in re-edit mode. Additional information can also be found 
by clicking the 'GenoTyping Details' tab on the Epigenetic Engine sub menu.  
 
Use Pragma®  
 
This turns on SWAMI Pragmatics®, a series of algorithms developed for SWAMI XPress™. 
Pragma will automatically select matrix nutrients for emphasis and de-emphasis, re-adjust specific 
food values via the Line Item Editor and set the Epigenetic Worldview as per the specifics of the 
client's intake form. Turn this on if you are uncertain as to how to use the Food Matrix, Line Item 
Editor and Worldview Adjuster (or just find them too technically daunting). Basically, it's like asking 
Dr. Peter D'Adamo what would his preferred settings be for your client!  
 
Category Portion Size and Frequency:  
 
This tool allows you to adjust the portion sizes and frequencies for the food categories. The 'base' 
values are the portion sizes and frequencies listed for that GenoType in The GenoType Diet book. 
From there, portions are adjusted a bit for the gender of the client. At that point additional 
refinements can be included. 
 Compute Best Combination: This allows SWAMI GenoType™  to compute the best 

Frequency/Portion combination for the client. This is done by computing the client's BMI and 
Total Energy Expenditure (TEE). 

 More Frequent/Larger Portion: This setting is good for greatly underweight clients or 
clients with cachexia or wasting disorders. 

 Normal Frequency/Larger Portion: This setting is good for clients who are athletes or 
who otherwise need to maintain their weight. 

 Normal Frequency/Normal Portion: This is the normal setting for clients with an ideal 
BMI 

 Normal Frequency/Smaller Portion: This is the normal setting for clients who are 
marginally overweight, who may just need a slight bit of calorie restriction. 

 Less Frequent/Normal Portion: This is the setting for overweight clients typically 
interested in weight loss. 

 Less Frequent/Smaller Portion: This is the setting for excessively overweight or otherwise 
obese clients. 
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Supplement Recommendations  
 
This field allows you to instruct SWAMI GenoType™ ; to recommend D'Adamo Personalized 
Nutrition supplements based upon aspects of your profile. The options are:  
• Don't recommend supplements: SWAMI GenoType™ will skip this section of the report 
• Show top indicated products only: This will recommend only the supplements that received the 

highest ratings count. This setting is useful for filtering 'information overload' 
• Show all well indicated products: A balance of the best-indicated products. We recommend that 

you use this setting 
• Show everything indicated: Will display any products that have accumulated a minimum number of 

ratings points. This will display a lot of products! However it is often the only setting that will 
uncover more one-of-a-kind products with more specific indications. 

 
 
Supplement Detail  
 
If you choose to have SWAMI GenoType recommend supplements, this field determines how much 
detail to render in the report:  
 
 Just the Summary (Just name and key details): Use this setting if you are also requesting that 

SWAMI show all indicated products 
 Full Report (Product details and descriptions): Use this setting if you've decided that you need 

more information about the products that have been recommended 
 
 
Print Extra Food Value Symbols  
 
If you choose to print extra food value symbols, SWAMI GenoType™   will identify foods that have 
been modified by external filters. Some clients appreciate the detail, others may feel that it is 
information overload.  
 
• Foods influenced by Traditional Chinese Medicine (TCM) values are identified by Chinese Yin Yang 

Symbol (☯) 
• Foods influenced by Traditional Ayurvedic Medicine values are identified by the Greek letter 

Lambda (λ) 
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Print Abbreviated Diet Report (Optional)  
 
You can print a highly abbreviated diet report, only containing the title sheet, a short description of 
the category, the category food values, Genoharmonics, and the wallet card. If you elect to show 
supplement recommendations, they will also print out. 
 
 
Print Abbreviated Diet Report (Optional)  
 
You can print in color or grey scale. 
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Sections D: Practitioner Notes 
 

 Expand this section if you plan to include this information. 
 
 
Expanding up this section opens up a text entry field that allows you to store notes about the client 
intake session.  Dates and times of subsequent editing sessions are automatically appended to this 
field. 
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Sections E: Food/Nutrient Matrix 
 
The FOOD/NUTRIENT MATRIX editor allows you add a final set of filters to the SWAMI GenoType™ 
food selection process. 
 
This subsection may take a little getting used to, but will be well worth the study. The Food Nutrient 
Matrix is a series of switches that allow the specific nutrient content of foods to influence their final 
resting values. Although very powerful, the Matrix is quite simple to use.   
 
Each modifiable nutrient is arrayed with two checkboxes: 
 

• Nutrients or constituents of foods which are universally deemed to have a negative effect on 
the body have two red colored icons. 

• Checking the box next to the larger red icon  will tell SWAMI GenoType™ to severely 
demote any food that is high in this constituent. In many instances this will in effect simply 
relegate the food to the avoid column. 

• Checking the box next to the smaller red icon  will tell SWAMI GenoType™ to 
moderately demote any food that is high in this constituent. 

• Nutrients or constituents of foods which are universally deemed to have a positive effect on 
the body have two green colored icons. 

• Checking the box next to the larger green icon  will tell SWAMI GenoType™ to strongly 
promote any food that is high in this constituent. In many instances this will in effect promote 
the food to the superfood column. 

• Checking the box next to the smaller green icon  will tell SWAMI GenoType™ to 
moderately promote any food that is high in this constituent. 

• Nutrients or constituents of foods which can have positive or negative effects in the body 
(depending on the clinical circumstances), have both a moderate demote and a moderate 
promote checkbox. 

 
 
 
Although you can tick as many boxes as you desire, avoid programming more than 4-5 nutrients into 
the food matrix. With each constituent you are increasing the chances that they will simply wind up 
canceling each other out. 
 
Instances of your choice having influenced specific food values are listed under each food category 
section as 'Physician Emphasize' and 'Physician Deemphasize'. 
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SWAMI GenoType™ Food Nutrient Matrix Editor 
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Sections F: Line Item Editor 
 
The LINE ITEM EDITOR tool allows you tweak individual food values, essentially permitting you to over-
ride the SWAMI GenoType™ food values with choices of your own. 

 

 
  
This can be handy in situations with impossible-to-predict food reactions (for example a client who is 
allergic to shellfish or who keeps Kosher despite it being allowed via the SWAMI GenoType™ 
selection process). 
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Tweaking Food Values in the Line Item Editor 
 
Making line item changes to a client's diet is easy. From the Line Item Editor box, scroll in the 
window (or use the alphabetic jump table at the bottom) until you see the food you are interested in 
tweaking. You will have five possible choices. Tick the bullet for the tweak you wish to implement. 
The five choices are 
 

• Convert the food automatically to a diamond superfood (symbolized by a diamond icon) 
• Convert the food automatically to a beneficial (symbolized by a green dot icon) 
• Convert the food automatically to a neutral (symbolized by a yellow dot icon) 
• Convert the food automatically to a returnable avoid (symbolized by a black dot icon) 
• Convert the food automatically to a permanent avoid (symbolized by a red dot icon) 
• Go back to having SWAMI GenoType™ calculate the food value (symbolized by a Swami 

Swirl icon)  
 
 
This last option is also how you 'deselect' that food. If you select the Swami option (either save the 
file or print the reports) when you open the file again for reediting, everything about that food will 
be deselected (since SWAMI GenoType™ will just go back to making the calculations). 
 
 
COOL  FEATURE: You can also click on the food to open up a pop-up window which displays the 
nutrient values for that food. Nutrients in bold are found in significant amounts in that food (greater 
than the SWAMI GenoType™ selection threshold). 
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Save SWAMI Profile 
 
At this point you’ve worked your way through the Client Intake Data Screen and now are presented 
with a few options concerning what you would like SWAMI GenoType™ to do with your data. 

Just save my information. I need to keep working on it 
If you tick this option (it is also the default) SWAMI GenoType™ will just save whatever data you’ve 
entered, even if the form is incomplete. Use this option if you are still compiling your information 
and want to add it to the Intake Data Screen over several sessions. 

Save and prepare to Print My Diet Report 
This will take you to the Print Report Screen. However, SWAMI GenoType™ will not run its search 
and sort routines and print out your diet report until it has all of its required Intake Data 
information.  

Save and prepare to Meal Plan and/or Generate Cook Book 
This will take you to the Menu and Recipe Screen. However, SWAMI GenoType™ will not run the 
Cook Book generator or Meal Plan Editor until it has all of its required Intake Data information.  

Save and prepare to Print Chart Report 
This will take you to the Print Chart Report Screen. However, SWAMI GenoType™ will not run the 
calculations until it has all of its required Intake Data information.  
 
 
 
 

 

SWAMI GenoType™ Save Profile Screen 
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V.  
SWAMI GenoType™ Diet Report 
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Getting Ready to Print Your Diet Report 
 
When you select SAVE AND PREPARE TO PRINT DIET REPORT option from the Intake Data 
Screen and have included all the required data, you will be taken to the Print Report Screen where 
you will have two options:  
 

• RE-EDIT THIS CLIENT:  Returns you to the Intake Data Screen to edit your data 
• PRINT DIET REPORT: Prints the Diet Report 

 
Go ahead and click on PRINT DIET REPORT. After a few seconds, your client’s diet report should 
appear on the screen. 
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SWAMI GenoType™ Print Diet Report Screen 
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Optimizing Your Diet Report 
 
The SWAMI GenoType™ report is already formatted and optimized for printout directly from your 
browser. From the browser’s File Menu, just select ‘Print.’ However, we should insure that your 
browser is configured to print out the SWAMI GenoType™ report with the best possible settings.  
 
Of these, the most important is to insure that the browser knows to print out ‘background’ colors, 
such as the green, yellow and orange columns of the food categories. SWAMI GenoType™ is easily 
readable in black and white, but it is much more user-friendly if printed in color. 
 

How to Insure that Background Colors Are Printed 

Macintosh 
 
Firefox 3.x:  From the File Menu, select Print, and then tick the boxes to ‘Print Background Colors’ 
and ‘Print Background Images’ 
 
Safari 3.x-4.x: From the File Menu, select Print, and then tick the boxes to ‘Print Background Colors’ 
and ‘Print Background Images’ 

 

 
 

Print Window in Firefox for the Mac 
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Windows 
 
Firefox 2.x-3.x:  From the File Menu, select Print, and then tick the boxes to ‘Print Background 
Colors’ and ‘Print Background Images’ 
 
Internet Explorer 6.x-7.x: From the Tools Menu, Select ‘Internet Options’, Click on the ‘Advanced’ tab, 
on the ‘Printing’ section check ‘Print Background Colors and Images’ 
 
 
 

 
 

Internet Options Window in IE for Windows 
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Setting Page Margins 
 
Re-setting Page Margins is normally not required as most browsers default to between ½ and ¾ inch 
margins on all four sides of the page, which works fine with SWAMI GenoType™. 
 
Internet Explorer 6.x-7.x: From the Tools Menu, Select ‘Internet Options’, Click on the ‘Advanced’ tab, 
on the ‘Printing’ section check ‘Print Background Colors and Images’. 
 

Firefox 
 
Re-setting Page Margins is normally not required as most Firefox browsers default to a ½ inch 
margin all around, which works fine with SWAMI GenoType™.   
 
However, if you need to reset margins in Firefox, from File Menu then go to ‘Page setup.’ Then 
click on the second tab that is called ‘Margins & Header / Footer.’ From there adjust the margin 
numbers to a smaller setting. 
 

Internet Explorer 7 
 
Internet Explorer Browsers default to a ¾ inch margin all around, which usually works fine with 
SWAMI GenoType™ but occasionally needs to be adjusted to ½ inch. 
 
By default there's a small image of a printer in the toolbar near the top right hand side of the 
browser, click that and go to ‘Page Setup.’ You will need to choose Paper Size: Letter Borderless 
from the drop down list and then set the margins to ½ inch. 
 

Internet Explorer 6 
 
Same as above for IE 7, except to get to the settings, go to File Menu, then ‘Page Setup’. After that 
it's exactly the same steps. 
 
 
 

Safari 
 
Safari normally prints out the SWAMI GenoType™ Diet Report just fine, but if you need to change 
margins, you will have to create a new page layout.  Here is a link that demonstrates how to do it: 
 
http://www.mintprintables.com/print-tips/adjust-margins-osx.php 
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Printing Out Your Client’s SWAMI GenoType™ Diet Report 
 
A typical SWAMI GenoType™ Diet Report is between 40 and 50 pages. The first thing you should 
see is the cover sheet. It looks like this: 
 
 
 

 
 

Typical SWAMI GenoType™ Diet Report Cover Page 
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Previewing Your Client’s SWAMI GenoType™ Diet Report 
 
One way to insure that your client’s Diet Report prints correctly is to preview the printout in your 
browser. This shows how the Report will look on paper pages versus your computer screen. 
 
In virtually all browsers, you access the ‘Print Preview’ function from the ‘Print’ option from the 
browser’s File Menu. If things look acceptable, you can then print directly from the Print Preview 
screen or click ‘Close’ or ‘Cancel’ to return to the Web page. 
 

Saving Your Client’s SWAMI GenoType™ as an Adobe Acrobat (.PDF) File. 
 
Adobe Acrobat .PDF (portable document files) are a convenient way to save your Diet Report.  
 
Because they can be saved to a flash drive, emailed or burnt to a CD, PDF files are also an excellent 
option if your printer is obsolete or only prints in black and white. You can make a copy of your diet 
report and take it to a local printer (such as Kinko’s) and for a nominal fee have them print it out for 
you. 
 
Saving a Diet Report as a printout is quite simple on the Mac, but a bit more complicated on a 
Windows computer.  
 

Macintosh 
 
From the File Menu, select Print and from the Print Menu, click the PDF button and select ‘Save as 
PDF’ from the options. 
 
Windows 
 
Printing to a PDF file is not natively supported on Windows computers. Many people install a 
program called ‘Acrobat Distiller’, which allows Windows users to save a file in the PDF format.  
 
SWAMI GenoType™ allows you to save your Diet Report as a PDF file by using a free online 
service. Just click on the button on the front page of the report labeled ‘Save Page as PDF.’  A small 
window will open up and the files will be converted. When complete you will be prompted to save 
the PDF file. 
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The SWAMI GenoType™ Diet Report in Detail 
 

Introductory and GenoType Information 
 
The first few pages of the SWAMI GenoType™ Diet Report contain introductory material and 
information about your GenoType determination.  There is also a short discussion about the 
difference between the Blood Type Diet and the GenoType Diet Systems. 
 

Further Customization 
 
SWAMI GenoType™ will usually provide information on additional steps that it has taken to further 
customize your Diet Report. These can include: 
 

Diet Emphasis 
 

• Notification that SWAMI GenoType™ has chosen to hybridize GenoType and Blood Type 
Diet values.  This is a powerful benefit to using a software based ‘dynamic’ approach to diet 
determination versus a ‘static’ approach normally performed with books and other forms of 
unchangeable information exchange.  

 

Emphasized and De-emphasized Nutrients 
 
SWAMI GenoType™ uses the Food Matrix Editor to supply an additional level of diet suggestions 
based upon your client’s unique health circumstances as reflected in the data that you’ve included in 
their intake form. This takes the form of foods that have been ‘emphasized’ or ‘de-emphasized’ based 
upon the appropriateness of the specific nutrients these foods possess. Emphasis and de-emphasis 
takes place after all blood type and GenoType calculations for that food have already occurred. 
 
Specific foods can receive ‘moderate’ or ‘strong’ emphasis or de-emphasis, based upon a calculated 
sum of the influences the nutrients contained in these foods would exert on your client’s health. 
These effects are applied to the foods after their blood type and GenoType values have been 
computed.  
 
‘Strong Emphasis’ might upgrade neutral food to ‘beneficial’ or even ‘highly beneficial.’  Moderate de-
emphasis might downgrade a temporary avoid (black dot) to permanent avoid. Although it is 
possible, it is rather uncommon for an avoid to convert to much more than a weak neutral despite 
even the strongest emphasis influences. If you’ve set SWAMI Pragmatics (via the USE PRAGMA control) 
SWAMI GenoType™ will calculate these best combination of these factors for you. 
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Epigenetic Worldview 
 
SWAMI GenoType™ has added an additional level of food filtering based upon unique aspects of 
your epigenetic heritage. This will set a preference for overall tone of the diet choices by virtue of 
your specific epigenetic worldview (Reactor, Receptor or Thrifty). This filter will rescan the nutrient 
database for special 'constellations' of nutrients that enhance or detract from the biologic 
characteristics of the selected worldview.  For example, although not often thought of as a ‘thrifty’ 
GenoType, a badly out of shape or de-conditioned Hunter might require specific support with 
regard to addressing weight control issues. If you’ve set SWAMI Pragmatics (via the USE  PRAGMA 
control) SWAMI GenoType™ will calculate these best combination of these factors for you. 
 
 

GenoHarmonic Food Clusters 
 
If you have elected to have SWAMI GenoType™ calculate which GenoHarmonic Function to use 
with your Diet Report, it will alert you to its conclusions here. The actual GenoHarmonic 
relationships are listed towards the end of the Diet Report. If you’ve set SWAMI Pragmatics (via the 
USE PRAGMA control) SWAMI GenoType™ will calculate these best combination of these factors for 
you. 
 
 

The Diet Categories 
 
After the program prints about ten pages of introductory report information, it then begins to 
output the diet. Each food category is printed separately.   
 
Each food category contains the same basic report data.  It begins by telling the client what would be 
the optimal portion sizes and weekly frequencies for that category. These portions and frequencies 
are highly specific to the client, SWAMI GenoType™ utilizing many of the biometric measurements 
to derive its calculations. 
 
There follows a small description that is blood type, GenoType and secretor specific and a series of 
special report notes based upon your specific parameters and priorities.   
 
The second part of the food category printout is a column-by-column breakdown by value, much like 
any of the blood type diet books. Let’s take a look at a typical diet category, in this case ‘Poultry’. 
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A typical SWAMI GenoType™ diet category 
 
 
Food choices are broken down into a green column that includes the most beneficial foods (food as 
medicines), a yellow neutral column (food as foods) and an orange column containing foods best 
avoided (foods as toxins). In the green column, certain foods may feature a diamond-like icon, a sign 
that the food may possess extra-benefits (enhance metabolism, fight aging, etc.). In the orange 
column some foods may feature a small black dot icon. This indicates that the food may eventually 
be re-integrated into the diet, perhaps after a short (60-90) day ‘washout period.’ 
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Categories that SWAMI GenoType™ will output values for will include: 
 

• Red Meats 
• Poultry 
• Fish and Seafood 
• Eggs and Roes 
• Dairy 
• Vegetable Proteins 
• Fats and Oils 
• Carbohydrates 
• Live Foods 
• Fruits 
• Spices 
• Beverages 
• Condiments 
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GenoHarmonic Foods  
 
GenoHarmonic Foods are unique combinations of certain foods which SWAMI GenoType™ has 
determined will yield the maximum epigenetic enhancement. The epigenetic value of the food is 
indicated by its star value, from exceptional (5 stars) to very good (3 stars). Simply reference a food 
you will be using at the left, and try to combine it with GenoHarmonic foods that are listed to the 
right. CAPITALIZED foods are Super-GenoHarmonic foods. 
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Other Features 
 

Wallet Card 
 
SWAMI GenoType™ will also print out a handy small version of your client’s diet, suitable for 
cutting out and keeping in a wallet. This helps keep the food values close at hand, when shopping or 
dining out. 
 

Exercise 
 
SWAMI GenoType™ will discuss specific exercise guidelines which may help enhance metabolism 
and help your client handle stress in a more resourceful way. 
 

Supplements 
 
If you’ve set the SUGGEST  SUPPLEMENTS switch, SWAMI GenoType™ will discuss specific nutritional 
supplements that might enhance your dieting experience. These are purely suggestive and are 
optional. 
 

Glossary 
 
SWAMI GenoType™ will output a small glossary of terms to help your client understand the core 
concepts behind the blood type diets and Dr. Peter D’Adamo’s latest book, The GenoType Diet. 
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VI.  
SWAMI GenoType™ Meal Planner   
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Using the SWAMI GenoType™ Meal Planner 
 
When you select SAVE AND PREPARE  TO MEAL  PLAN and/or GENERATE COOK BOOK from the Intake Data 
Screen and have included all the required data, you will be taken to a screen where you will have 
three options:  
 

• Re-edit Your Intake:  Returns you to the Intake Data Screen to edit your data 
• Cook Book Creator: Collects recipes appropriate for your Diet Report and organizes them into 

a book 
• Meal Planner: takes you to a weekly meal-planner program 

 
Go ahead and click on GO TO MEAL PLANNER. After a few seconds, The Meal Planner interface should 
appear on the screen.  
 

 
 

SWAMI GenoType™ Meal Planner Screen 
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SWAMI GenoType™ Meal Planner Basics 
 
When you select MEAL  PLANNER from the Print Report Screen, don’t be surprised if it takes 15-30 
seconds for the screen to load. SWAMI GenoType™ is doing a lot of calculations! Soon enough, you 
will see the following screen: 

 

 
 

SWAMI GenoType™ Generate Meal Planner Screen 
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Getting Around in SWAMI GenoType™ Meal Planner 

 
The SWAMI GenoType™ Meal Planner Interface is very much like the Intake Data Screen and 
Manage Account Screens that we learned about when we worked through the Diet Report Module. 
Up top are upper tabs that help you get around, and a central work area with a series of lower sub 
tabs. 
 

The upper tabs include: 
 

• Meal Planner: Where you are right now 
• Edit Your Intake Data: Takes you back to the Intake Data Screen if you need to work on 

your intake profile 
• Recipes: Takes you to the Cook Book Creator 
• Manage Account: Takes you to your account screen 
• SWAMI Support: takes you to the SWAMI tech support page 
• Log In/Log Out: ends you SWAMI GenoType™ Session 

 

The lower tabs include: 
 

• Meal Planning:  Where you are right now 
• Add Recipe: Lets you add a recipe to the SWAMI GenoType™ Recipe Database 
• List Recipes: Lets you list and view available recipes 

 

Next there are two link options:  
 

• Click here to refresh screen with latest changes 
 
Normally you can just ignore this link. However if you’ve generated a meal plan and then returned to 
this page via the BACK button of your browser, the page may not have the latest settings, if so, then 
just refresh the page. 
 

• Click here to start a new meal plan 
 
Normally, if you’ve already created a meal plan SWAMI GenoType™ will load it as a default. Clicking 
here tells SWAMI GenoType™ to start fresh with a blank form. 
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Check Box Options 
 
There are also a few check box options. Tick these as you wish: 
 

• Print recipes used by this meal plan 
 
Ticking this box will tell SWAMI GenoType™ to include any recipes used in the meal plan. 
 

• Print shopping list for prime ingredients used by this meal plan 
 
Ticking this box will tell SWAMI GenoType™ to print a shopping list for all major used in the meal 
plan. 
 
 
 
 
Finally, we are at the heart of the MEAL PLAN EDITOR. 
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Using the SWAMI GenoType™ Meal Planner 

 
The SWAMI GenoType™ Meal Planner is organized by the seven days in one week. 
 
Each day (Sunday thru Saturday) has six Meal Entry Fields, each for one meal or snack: 
 

• Breakfast 
• Morning Snack 
• Lunch 
• Afternoon Snack 
• Dinner 
• Evening Snack 

 
 
Each Meal Entry Field contains appropriate choices for that meal, including individual foods and 
appropriate recipes as per the food values contained in your diet report. In other words, the choices 
for each meal are already selected to contain recipes and food choices right for your type! 
 
Now you know why it took so long to load the page! 
 
Constructing a meal plan for a day is simple. Use the pull-down menu for that day and select a food 
or recipe combination. Continue to select food combinations for that meal until you are satisfied. 
Each additional choice is magically added to the grouping for that meal. 
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Making Intelligent Choices in the Meal Planner 
 
Pull-down choices contain coding that can help you make more intelligent food choices: 
 

• More nutrient dense foods are listed towards the top of the selection list 
• Recipes list the number of beneficial food contained in the recipe in square brackets [ ] 
• Superbeneficial foods are identified with a diamond icon 

 

 

 
 

SWAMI GenoType™ Meal Planner Selection Screen 
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Cloning Day Meal Plans Using Sunday 
 
A quick way to generate a basic weekly plan is to use the ‘Clone Sunday’ checkbox for other days of 
the week. For example, you could do a meal plan for Sunday, tick the ‘Use Sunday as master 
template’ check box for the other days, save the meal plan, and then reload the meal plan and work 
from there.  
 
For example if you like to use the Chocolate Cherry Unibar as an evening snack, select it for evening 
snack for Sunday, then clone it to the other days. When you save and reload the meal plan, it will be 
added to any day that you cloned it to. Just remember to un-tick the box when you want to begin 
specifically working on that day! 
 
 
 
 

   
SWAMI GenoType™ Meal Planner Template Screen 

 

 
When you’ve finished working on your meal plan, press the GENERATE MEAL PLAN BUTTON, and you will 
be taken to the Meal Plan Printout. 
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Printing the Meal Plan Report 
 
 
A typical SWAMI GenoType™ Meal Plan Printout is 2-3 pages. If you’ve opted to also include 
recipes contained in the Meal Plan, it could run 10-12 pages depending on the complexity of the 
recipes. 
 
You can print out the SWAMI GenoType™ Meal Plan by simply using the File Menu ‘Print’ option 
from your browser. 
 

 

 
 

SWAMI GenoType™ Meal Plan Print Screen 
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VII.  
SWAMI GenoType™ Cook Book Creator 
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Accessing the SWAMI GenoType™ Cook Book Creator 
 
When you select ‘Go To Recipes and Meal Planning’ from the Intake Data Screen and have included 
all the required data, you will be taken to the Print Report Screen where you will have three 
options:  
 

• Re-edit Your Intake:  Returns you to the Intake Data Screen to edit your data 
• Cook Book Creator: Collects recipes appropriate for your Diet Report and organizes them 

into a book 
• Meal Planner: takes you to a weekly meal-planner program 

 
Go ahead and click on COOK BOOK CREATOR. After a few seconds, The SWAMI GenoType™ Cook 
Book Creator interface should appear on the screen. You can also access the Cook Book Creator 
by clicking on the ‘Recipes’ tab from either the Meal Planner or the Edit Intake Data Screen. 

 

 
 

How to access SWAMI GenoType™ Cook Book Creator Screen 
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Using the SWAMI GenoType™ Cook Book Creator 

 
The SWAMI GenoType™ Cook Book Creator is very easy to navigate.  
 
Once the screen appears, you will be asked to supply a preference: 
 

• Print recipes with three or more diamond beneficials (xx recipes) 
• Print recipes with two or more diamond beneficials (xx recipes) 
• Print recipes with one or more diamond beneficials (xx recipes) 
• Print all permissible recipes (xx recipes) 

 
Each option will contain the number of recipes SWAMI GenoType™ has found which meet the 
criteria.  
 
Obviously, each option going down the list prints a greater number of recipes. 
 

 

A note about recipe appropriateness 
 
Recipes are ‘tagged’ with major ingredients contained in the recipe. Minor ingredients may 
occasionally find their way into the recipe that may not fit exactly into your Diet Report Food 
Values. Usually this is the case of the Recipe Author using multiple options for different blood 
groups, secretor types and GenoTypes. Always double-check recipes to insure their appropriateness 
for you particular plan. 
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SWAMI GenoType™ Cook Book Creator Screen
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Typical SWAMI GenoType™ Cook Book Page 
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VIII.  
Technical Support and Getting Help 
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Using the SWAMI GenoType™ Technical Support 

  
 
Perhaps it is fitting that this User manual ends where it began: At the SWAMI GenoType™ Support 
Screen. 
 
We take Customer Support very seriously and will do whatever we can to insure that you receive 
optimum value for your use of this software.  
 
However let’s discuss a few things we can’t do: 
 

• We can’t provide medical advice regarding how you should answer questions about your 
health history, family history or laboratory data.  

• We can’t provide assistance with regard to techniques required to perform any of the test or 
measurements required to run the software. This information is supplied through other 
avenues, such as Dr. Peter D’Adamo’s books, videos and instruction materials packaged with 
testing kits. 

• We can’t solve problems with your computer hardware. SWAMI GenoType™ is designed to 
run on any modern computer which can navigate the Internet. However computers come in 
many shapes and sizes and we cannot know how fix every possible hardware mis-
configuration. 

 
We can try to help you: 
 

• Configure your browser correctly so as to run the program effectively and correctly print 
out the reports.  

• Guide you through the interface, should aspects of the program seem daunting or confusing. 
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Accessing Technical Support 
 
 
From the SWAMI SUPPORT tab, click on the lower tab for TECH SUPPORT 
 
 

 
 

SWAMI GenoType™ Support Screen 
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You will be taken to the SWAMI GenoType™ Tech Support window. Most Tech Support can be 
accomplished via our online help system. If Tech Support is available, the screen will show that a 
Tech Support person is online and available to help you. When you click on the icon a chat window 
will open up and you can type in your question or problem. 
 
If Tech Support is not available at this time, the icon will be grayed out, and clicking on it will allow 
you to send an e-mail to Tech Support.  Response time varies with demand but we try to respond to 
all inquiries within 24 hours. 
 
You can also contact SWAMI GenoType™ Tech Support by phone at  
 
1.203.761.0042 
 
Monday-Friday, 9:00 AM-5:00 PM EST 
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SWAMI GenoType™ Online Support Screen 
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IX.  
SWAMI GenoType™ Tips and Tricks 
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1. Protecting Your SWAMI GenoType™ Report Hard Copy 
 
This is how SWAMI GenoType™ Reports are supplied to patients at the D’Adamo Clinic. 
 

• Purchase ½ inch plastic binders that have clear plastic cover slips on front 
• Purchase three-hole punched paper 
• Purchase three hole dividers 
• Print out the report 
• Insert front page into binder front cover slip 
• Place rest of printout in binder 
• Insert one divider at beginning of food categories 
• Insert one divider at beginning of the GenoHarmonic Pages 
• Insert one divider at beginning of the Supplement Pages 

 
You can also use the same treatment for the recipe printout. 
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X.  
SWAMI GenoType™ Appendices 
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SWAMI GENOTYPE™ END USER LICENSE AGREEMENT (EULA) 
 
 
END-USER LICENSE AGREEMENT FOR SWAMI GENOTYPE™ (“SOFTWARE PRODUCT”) 
 
IMPORTANT PLEASE READ THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT 
CAREFULLY BEFORE CONTINUING WITH THIS PROGRAM: Epigenetic Archetypes, LLC End-
User License Agreement ("EULA") is a legal agreement between you (either an individual or a single 
entity) and Epigenetic Archetypes, LLC. for the Epigenetic Archetypes, LLC software product 
identified above which may include associated software components, media, printed materials, and 
"online" or electronic documentation ("SOFTWARE PRODUCT").  
 
By installing, copying, or otherwise using the SOFTWARE PRODUCT, you agree to be bound by the 
terms of this EULA. This license agreement represents the entire agreement concerning the program 
between you and Epigenetic Archetypes, LLC, (referred to as "licenser"), and it supersedes any prior 
proposal, representation, or understanding between the parties. If you do not agree to the terms of 
this EULA, do not install or use the SOFTWARE PRODUCT. 
 
Copyright laws and international copyright treaties, as well as other intellectual property laws and 
treaties protect this SOFTWARE PRODUCT.  
 
The SOFTWARE PRODUCT is licensed, not sold. 
 
A. GRANT OF LICENSE. 
 
The SOFTWARE PRODUCT is licensed as follows: 
 

1. Installation and Use: Epigenetic Archetypes, LLC grants you the right to a single one-time, one-
client use of this SOFTWARE PRODUCT on your computer, via the Internet and running on a 
valid browser platform. 

 
B. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS. 
 

1. Maintenance of Copyright Notices: You must not remove or alter any copyright notices on any 
and all copies of the SOFTWARE PRODUCT. 

2. Distribution: You may not distribute registered copies of the SOFTWARE PRODUCT to third 
parties. Evaluation versions available for download from Epigenetic Archetypes, LLC's websites 
may be freely distributed 

3. Prohibition on Reverse Engineering, Decompilation, and Disassembly: You may not reverse 
engineer, decompile, or disassemble the SOFTWARE PRODUCT, except and only to the 
extent that such activity is expressly permitted by applicable law notwithstanding this limitation 

4. Rental: You may not rent, lease, or lend the SOFTWARE PRODUCT. 
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5. Support Services: Epigenetic Archetypes, LLC may provide you with support services related 
to the SOFTWARE PRODUCT ("Support Services"). Any supplemental software code 
provided to you as part of the Support Services shall be considered part of the SOFTWARE 
PRODUCT and subject to the terms and conditions of this EULA 

6. Compliance with Applicable Laws: You must comply with all applicable laws regarding use of 
the SOFTWARE PRODUCT 

 
 
C. TERMINATION 
 

1. Without prejudice to any other rights, Epigenetic Archetypes, LLC may terminate this EULA if 
you fail to comply with the terms and conditions of this EULA. In such event, you must destroy 
all copies of the SOFTWARE PRODUCT in your possession. 

 
 
D. COPYRIGHT 
 

1. All title, including but not limited to copyrights, in and to the SOFTWARE PRODUCT and any 
copies thereof are owned by Epigenetic Archetypes, LLC or its suppliers. All title and 
intellectual property rights in and to the content which may be accessed through use of the 
SOFTWARE PRODUCT is the property of the respective content owner and may be 
protected by applicable copyright or other intellectual property laws and treaties. This EULA 
grants you no rights to use such content. All rights not expressly granted are reserved by 
Epigenetic Archetypes, LLC. 

 
E. STRUCTURE/ FUNCTION CLAIMS 
 

1. This SOFTWARE PRODUCT is licensed to the end-user for education purposes only. You are 
advised to consult with your physician before beginning this or any other dietary program 

2. Statements made in this software have not been evaluated by the Food and Drug 
Administration. This product is not intended to diagnose, treat, cure or prevent any disease 

3. Certain persons, considered experts, may disagree with one or more of the conclusions 
reached as a result of using this SOFTWARE PRODUCT. 

 
F. NO WARRANTIES 
 

1. Epigenetic Archetypes, LLC expressly disclaims any warranty for the SOFTWARE PRODUCT. 
The SOFTWARE PRODUCT is provided 'As Is' without any express or implied warranty of 
any kind, including but not limited to any warranties of merchantability, noninfringement, or 
fitness of a particular purpose. Epigenetic Archetypes, LLC does not warrant or assume 
responsibility for the accuracy or completeness of any information, text, graphics, links or 
other items contained within the SOFTWARE PRODUCT. Epigenetic Archetypes, LLC makes 
no warranties respecting any harm that may be caused by the transmission of a computer virus, 
worm, time bomb, logic bomb, or other such computer program. Epigenetic Archetypes, LLC 
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further expressly disclaims any warranty or representation to Authorized Users or to any third 
party. 

 
G. LIMITATION OF LIABILITY 
 

1. In no event shall Epigenetic Archetypes, LLC be liable for any damages (including, without 
limitation, lost profits, business interruption, or lost information) rising out of 'Authorized 
Users' use of or inability to use the SOFTWARE PRODUCT, even if Epigenetic Archetypes, 
LLC has been advised of the possibility of such damages. In no event will Epigenetic 
Archetypes, LLC be liable for loss of data or for indirect, special, incidental, consequential 
(including lost profit), or other damages based in contract, tort or otherwise. Epigenetic 
Archetypes, LLC shall have no liability with respect to the content of the SOFTWARE 
PRODUCT or any part thereof, including but not limited to errors or omissions contained 
therein, libel, infringements of rights of publicity, privacy, trademark rights, business 
interruption, personal injury, loss of privacy, moral rights or the disclosure of confidential 
information. 


